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I. INTRODUCTION 

 
IEEETRAN.DOT is the official IEEE Transactions/Journals 
author's  template for Microsoft Word for Windows. The 
current template covers Word versions 6 and 7. The 
template is essentially a set of styles that extend Word's 
NORMAL.DOT template.  
 
Papers submitted to IEEE Publishing Services that adhere 
to these guidelines are eligible for a discounted production 
rate, because the work you do to prepare your document 
saves us time and effort in converting it for use in our 
composition software. 
 

II. THIS GUIDE AS SAMPLE DOCUMENT 

 
This guide shows what various styles in IEEETRAN.DOT 
look like. An attempt has been made to approximate the 
look-and-feel of IEEE Transactions papers, although we 
realize that this can only be a very rough approximation. 
Final IEEE papers are typeset using composition software 
that allows greater control over layout and fonts than is 
possible in Word.  
 
The look-and-feel of IEEETRAN.DOT papers, then, is 
offered for aesthetic reasons and to emphasize that your 
paper will be set in two-column format, which may become 
a factor in your breaking of equations. You may also get a 
better feel for your final page count, though this  
too can only be an approximation.  
 
Recognizing that what IEEETRAN.DOT does in the way of 
typesetting is only a temporary simulation of your paper’s 
published appearance, you may well opt for different style 
parameters while editing, either by resetting via the 
Style…  item under the Format menu or by running the Fix 
Page Layout macro under the IEEE Macros menu and 
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choosing not to go with two-column, single-spaced format. 
Another possibility is to select Normal under the View  
menu, to improve visibility on the screen. None of these 
alterations will affect your paper’s ability to be converted 
for production use. 
 

III. GETTING STARTED 

 

A. Creating A New Paper 
 
If you wish to begin writing a paper from scratch using the 
IEEETRAN.DOT template, or create an empty document in 
the template for cutting and pasting text from an existing 
file in some non-Word format, follow these steps:  
 
1. Copy IEEETRAN.DOT into your templates directory, 

e.g., C:\MSoffice\Templates, so that it will be available 
from within Word.  

2. Start up Microsoft Word. 
3. In the File menu, select New. In the New dialog, select 

IEEETRAN.DOT.  
4. IEEETRAN.DOT's startup macro will pop up a dialog 

box asking you to type in text for several of your 
paper's elements. If you don't have all of the 
information in front of you, or if you are uncertain of 
the final content of these areas, you can type in some 
text or simply leave the default text in place. You can 
always edit these elements later, in the document 
proper. The macro will not be repeated when you re-
open the document. 

 
Your cursor should  now be positioned near the top of the 
paper, ready for you to begin writing. 1  
 

B. Converting an Existing Word Paper 
 
Papers originally composed in Word version 5 or earlier 
will have to be converted to Word 6 or 7 format in order to 
attach IEEETRAN.DOT. Once this is done, the paper will 
still lack styles specific to IEEETRAN.DOT. Additionally, 
you may not have used Word styles at all to mark up  
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the paper when you created it. In any event, some re-
styling with IEEETRAN.DOT will have to be done in order 
to submit your Word file in compliance with these 
guidelines. To prepare your paper for re-styling, follow 
these steps: 
 
1. Copy IEEETRAN.DOT into your templates directory, 

e.g., C:\MSoffice\Templates, so that it will be available 
from within Word.  

2. Start up Word and open the existing Word 6 or 7 
document. 

3. Under the File menu, select Templates… , the top of 
the resulting dialog box will show NORMAL.DOT, or 
perhaps another template, as the current attachment. 

4. Click on the Attach…  button. This will bring up the 
contents of your templates directory. Double click on 
IEEETRAN.DOT. 

5. Still in the Templates…  dialog, click the checkbox 
marked “Automatically update  styles,” then click OK. 

6. Finally, run the Fix Page Layout macro from the IEEE 
Macros menu. 

 
You will now need to go through your paper from start to 
finish, using the style menu or the Re-style or Edit macro 
under IEEE Macros to re-define the elements listed in 
section VI of  this guide. Styles in the existing paper that 
have exactly the same names under IEEETRAN.DOT, 
such as Heading 1, do not need to be re-styled. 
 

IV. MATH 

 
In addition to using IEEETRAN.DOT, you must make sure 
to use either the Microsoft Equation Editor or the 
MathType add-on for all math objects in your paper. 
 
A math object is defined as any equation or fragment 
containing mathematical symbols (including Greek 
characters, super- and subscripts) that appears either in-
line (in the flow of normal text) or as a display equation (in 
its own space between lines of text). In particular, you must 
avoid using Word fonts or character calls for in-line 
“quickies” such as single variables with super- or 
subscripts. Preparing your math with the equation editor or 
MathType allows us to automate conversion of most of the 
math in your paper to our in-house math format, TeX, 
while allowing you to format math for the hard copy of 
your paper that you will submit along with your Word file 
and ascii dump.  
 
The MathType add-on for Word is a commercial product 
that you may or may not have purchased already for your 
own use. If you have MathType,we encourage you to use it 
for as much of your math as possible. If not, you can use 
the Microsoft Equation Editor, which comes as a part of 
Word at no extra charge. 
 

V. MARKUP 

 
Markup defines the parts of your paper: the title, headings, 
lists, and so forth. Each of these elements is given an 
appropriate name, and certain formatting instructions are 
associated with that name, so that title text, for instance, 
always looks a certain way. In Word, the mechanism for 
associating an element name with its formatting 
conventions is called a style.  
 
Style names appear in the pull down style menu along the 
left hand side of your Word window. Typically, you 
highlight an area of text that you wished to designate with 
a certain style, then select the appropriate name on the 
style menu.  
 
This does two things. First, it associates the style name 
with the highlighted text. This connection is hidden within 
the Word file. Second, it applies the formatting rules 
associated with the style to the highlighted text. 
IEEETRAN.DOT offers an alternative method for applying 
certain styles (the Re-style or Edit macro), but keep in 
mind that highlighting, then selecting a style from the 
styles menu can always be used to re-style. 
 
Re-style or Edit macro does not handle all style names, just 
those most commonly used in IEEE journal papers, mostly 
style names unique to IEEETRAN.DOT.  
 
The macro allows you to add or edit styles without first 
highlighting any text. If the style already exists, the macro 
will find the first instance of it and place your cursor there. 
If no instance of the style can be found, the macro will 
activate the style at the current cursor position, ready for 
your input. In this case, remember that the style will 
remain active until you “turn it off” by selecting a different 
style or by moving your cursor to another point in the 
document. 
 

VI. IEEE PAPER STYLES 

A. Style Reference 
 
Here’s an alphabetical reference for styles used in IEEE 
papers. Some, like “Heading 1,” are borrowed from Word's 
NORMAL.DOT; others are unique to IEEETRAN.DOT. 
Note that paragraphs do not require special styling and 
should be left with the “Normal” style. 
 
Abstract -- Includes all text for your abstract. Formatting 
is 9-point bold italic.  
 
Authors -- Comprises the entire comma-delimited list of 
authors, starting with the principal author. Appears in 



frame centered on the page, and should appear after the 
Title area.  
Depending on the size of Title content, this frame may 
have to be repositioned manually. Nested within this style 
may be one or more MemberType style areas. 
 
AuthorInfo -- AuthorInfo can be created with the Add 
Author Info macro, which contains author affiliation 
information. This style should be unique within the paper. 
It produces a special footnote on the first page. The 
footnote has a non-printing symbol as its reference marker 
so as  
not to interfere with the numbering of regular footnotes 
later in the paper. 
 
Heading 1 -- Top-level heading. Auto-numbered, so you 
shouldn't add Roman numerals of your own. Appears 
centered on the column with smallcaps.  
 
Heading 2 -- Level-two heading. Auto-numbered, so you 
shouldn't add capital letters of your own. 
 
Heading 3 -- Level-three heading. Auto-numbered, so you 
shouldn't add Arabic numerals of your own. Note that only 
heading levels 1 through 3 are supported in IEEE style.  
 
IndexTerms -- Optional list of index terms (keywords). If 
you supply no index terms, this style should be removed 
entirely. 
 
Lemma -- Heading (only) for a lemma. 
 
List Number-- Regular, numbered, and bulleted lists. Used 
just as within Word normally. Each entire list receives the 
list style, and carriage returns within the list area define 
list items. 
 
MemberType -- The member grade, if any, of an author, 
as part of the Authors area. Each MemberType instance is 
preceded (and followed, if necessary) by a comma as part 
of the comma-delimited list of authors. 
 
References -- Reference section (called bibliography 
outside the IEEE). A special kind of numbered list. There 
should be only one References style area in your paper. 
Auto-numbered, so you shouldn't add numbering of your 
own. Entire section receives References style, and 
paragraphs within the area define individual references. 
 
Theorem -- Heading (only) for a theorem. Derived from 
Heading 3. 
 
Title -- Full paper title. Should be the first item in the 
paper. Appears in 24-point Times New Roman type within 
a frame centered on the page. Depending on the size of 
Title contents, the Authors frame may have to be 
repositioned manually. 

 
 

B. Order of Appearance 
 
Here’s a list of IEEE-unique styles in order of appearance: 
 
Title 
Authors (including MemberType areas)  
AuthorInfo (special footnote) 
Abstract 
IndexTerms 
Heading 1 
Heading 2 
Heading 3 
Acknowledgment 
References 
 
Since Word will allow you to use any style over and over, 
IEEETRAN.DOT provides the  Check Styles macro to 
check your paper for redundant elements. All other styles 
may be repeated as often as necessary. 
 

VII. IEEE MACROS 

 
Here’s a reference list of the four macros listed under the 
IEEE Macros menu that activates when you create a new 
document using IEEETRAN.DOT or attach 
IEEETRAN.DOT to an existing Word document. 
 
Fix Page Layout -- Performs a number of formatting and 
page layout functions. Normally run after attaching 
IEEETRAN.DOT to an existing Word paper, but it can be 
run at any time. 
 
Re-style or Edit -- Goes to the next instance of the 
selected style, if it finds one. Otherwise, restyles the text 
surrounding the current cursor position. If current cursor 
position is within an IEEE-unique style, prompts you 
before re-styling. 
 
Add Author Info -- Creates the author affiliation area as a 
special footnote on the first page. Use this macro to re-
create a deleted author info area or add one for the first 
time. There should be only one instance of this style. 
 
Check Styles --Tells you how many instances you have of 
the styles that are supposed to be unique, e.g., you know 
something’s wrong if your  paper has three titles. But note 
that multiple style areas may sometimes be counted if you 
have carriage returns within a single style area. Carriage 
returns within these areas should be deleted. 
 



VIII. SUBMITTING YOUR PAPER 

 
As outlined in the general Transactions/Journals paper 
author’s guide, your complete submission should include 
hard copy and an ascii dump of your paper, plus any 
graphics files and captions for figures, prepared as required 
in that guide. In addition, you should send at the same time 
(via whatever medium) a copy of your Word binary file. 
Always make sure to keep your original, in case your paper 
needs to be retransmitted. 
 


